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Managing the OATS Certificate

The OATS Certificate is used by a user’s mail client to S/MIME encrypt email
messages, and is required for all mail clients that will be exchanging order data
with OATS. An OSO that will submit files via email must obtain the OATS
Certificate via a non-encrypted, unsigned email request, and then store the
OATS Certificate within the mail client’s Address Book. Each OSO that submits
files via email is required to refresh the OATS Certificate annually by deleting the
old one and requesting a new one. (Although FINRA does not intend to require
you to refresh the OATS Certificate more often than once annually, it reserves
the right to do so if necessary.) Use the addresses below to request the OATS
Certificate.

Note: All users must request separate OATS Certificates for the test and
production environments. Use the Internet email address to request the OATS
Certificates, even if you are a subscriber to the OATS network. In addition,
each individual workstation used to access the OATS network must have its
own OATS Certificate, i.e., one Certificate cannot be used on more than one
workstation.

Table 1. Email Addresses for Requesting the OATS Certificate

Access Type Test Production
Email via Internet testoatskey@finra.org oatskey@finra.org

To Request the OATS Certificate

The first procedure applies only to Outlook Express 5.0, while the second
procedure applies only to Netscape Messenger 4.72. The steps involved in
requesting the OATS Certificate may vary for other mail clients and versions. For
assistance in using versions other than those mentioned above, call FINRA
Business and Technology Support Services at 1-800-321-6273.

To Request the OATS Certificate Using Outlook Express
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1. In the Outlook Express Inbox, click . The New Message dialog box
appears.

2. In the To box, type testoatskey@finra.org to access the test environment, or
oatskey@finra.org to access the production environment.

3. In the Subject box, type OATS Certificate Request (this statement is not
case-sensitive but must be spelled correctly).

4. Leave the body of the message blank. Do not encrypt or digitally sign the
message.

Tip: Before sending the request for the OATS Certificate, confirm that the
address from which you want to send FOREs is specified as the default
account. To do this in Outlook Express, from the Tools menu, select Accounts.
The Internet Options dialog box appears. If the account from which you want
to send FOREs is already the default, “mail (default)” appears in its Type
column. To set a different account as the default, select it from the list, and then

click .

5. Click .

To Request the OATS Certificate Using Netscape Messenger

1. In the Netscape Messenger Inbox, click . The Composition dialog box
appears.

2. Click to display the Address tab. In the To box, type
testoatskey@finra.org to access the test environment, or
oatskey@finra.org to access the production environment.

3. In the Subject box, type OATS Certificate Request (this statement is not
case-sensitive but must be spelled correctly).

4. Leave the body of the message blank. Do not encrypt or digitally sign the
message.
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Tip: Before sending the request for the OATS Certificate, confirm that the
address from which you want to send FOREs is specified. To do this in
Netscape Messenger, from the Edit menu, select Preferences. The
Preferences dialog box appears. Select the Identity category under Mail &
Newsgroups. The Identity dialog box appears. Confirm that the Email
address and Reply-to address boxes both reflect the email address from
which you intend to submit FOREs to OATS. If you made a change to the

addresses, click . If you did not make a change, click .

5. Click .

To Trust the OATS Certificate

When you first receive the OATS Certificate via email, you may need to specify
within your mail client that FINRA is a trusted sender of email. Once the OATS
Certificate is trusted within your mail client, it may be stored in the mail client’s
Address Book and then used to exchange order data with OATS.

The first procedure applies only to Outlook Express 5.0, while the second
procedure applies only to Netscape Messenger 4.72 The steps involved in
trusting the OATS Certificate may vary for other mail clients and versions. For
assistance in using versions other than those mentioned above, call FINRA
Business and Technology Support Services at 1-800-321-6273.

To Trust the OATS Certificate Using Outlook Express
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1. In the Outlook Express Inbox, select the OATS reply message.

2. Double-click the message to open it. If you see Security: Digitally signed
and verified underneath the Subject line of the reply email, the Certificate
has been automatically trusted and you can add the Certificate to your email
address book. To complete this, see ‘To Add Certificate to the Address
Book’ later in this chapter. If the body of the message indicates there are
security problems with the Certificate, as seen in Figure 1, proceed with step
3.

Figure 1. OATS Certificate Response, Digital ID Not Trusted

3. Click . The Signing digital ID properties dialog box appears (see
Figure 2).

Figure 2. Signing Digital ID Properties Dialog Box

oatsfiles@finra.org
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4. Select the Explicitly Trust this Certificate option.

5. Click .

6. Click .

To Trust the OATS Certificate Using Netscape Messenger
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1. In the Netscape Messenger Inbox, select the OATS reply message.
Figure 3. Netscape Messenger Inbox

2. Without opening the message, click the attachment icon in the lower half of
the Inbox. If the text on the icon reads “Signed” (see Figure 3), the Certificate
is already trusted, and you do not need to continue with this procedure. If the
text on the icon reads, “Invalid Signature,” continue with this procedure to
trust the Certificate. The Security Info dialog box appears (see Figure 4).

oatsfiles@finra.org

devoatsst@finra.org
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Tips:
 If you cannot see the attachment icon in the Inbox, from the View menu,

click Show and then Message. The lower half of the Inbox appears,
displaying the OATS Certificate attachment.

 If the OATS Certificate does not accompany the reply message, this
may indicate that your server software is not accepting signed mail (this
is often the default setting). See your network administrator to have the
option set to receive signed mail so that you can exchange order data
with OATS. For more details, contact FINRA Business and Technology
Support Services.

Figure 4. Security Info Dialog Box

3. Click View/Edit. The View/Edit A Personal Certificate dialog box appears.
Scroll down to see the shole dialog box (see Figure 5).

Figure 5. View/Edit A Personal Certificate Dialog Box
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4. Click Trust this certificate even though it does not have a trusted issuer.
The Security Info dialog box appears.

5. Click .

To Add the OATS Certificate to the Address Book

The first procedure applies only to Outlook Express 5.0 (which accompanies
Internet Explorer 4.0, version 4.72), while the second procedure applies only to
Netscape Messenger 4.72. The steps involved in adding the OATS Certificate to
the mail client’s Address Book may vary for other mail clients and versions. For
assistance in using versions other than those mentioned above, call FINRA
Business and Technology Support Services at 1-800-321-6273.

To Add the OATS Certificate to the Address Book Using Outlook Express

oatsfiles@finra.org oatsfiles@finra.org

FINRA FINRA
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1. In the Outlook Express Inbox, select the OATS reply message.
Figure 6. Outlook Express Inbox

2. Double-click the message to open it. If the Security box in the header does
not read “Digitally signed and verified” as seen in Figure 7, you must trust the
Certificate. See “To Trust the OATS Certificate,” as discussed earlier in this
chapter.

Figure 7. OATS Certificate Response Message

3. Place your cursor in the From box, and then right-click. A pop-up menu
appears.

oatsfiles@finra.org

oatsfiles@finra.org

oatsfiles@finra.org
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4. From the pop-up menu, select Add to Address Book. The Properties
window for the address in the From box appears.

5. Click to add the OATS address and Certificate to your Address
Book. The Outlook Express Inbox appears.

To Add the OATS Certificate to the Address Book Using Netscape
Messenger

Upon receipt of an email from OATS, Netscape Messenger automatically stores
the OATS Certificate in its Address Book. However, it may still be necessary to
trust the OATS Certificate. See “To Trust the OATS Certificate,” as discussed
earlier in this chapter.

To Refresh the OATS Certificate

The OATS Certificate must be refreshed annually. Before requesting a new
Certificate from OATS, use the following procedure to delete the previous year’s
Certificate.

The first procedure applies only to Outlook Express 5.0 (which accompanies
Internet Explorer 4.0, version 4.72), while the second procedure applies only to
Netscape Messenger 4.72. The steps involved in refreshing the OATS Certificate
may vary for other mail clients and versions. Refer to “Managing the OATS
Certificate” in this chapter, for assistance in refreshing the OATS Certificate and
transmitting a FORE file via email. For assistance in using versions other than
those mentioned above, call FINRA Business and Technology Support Services
at 1-800-321-6273.

To Refresh the OATS Certificate Using Outlook Express

1. From the Outlook Express Inbox, click . The Address Book window
appears.

2. Click the OATS address entry.

3. Click or press the Delete key on your keyboard. A confirmation
message appears.

4. Click Yes to delete the OATS Certificate.

5. Request a new OATS Certificate.

6. Trust the new OATS Certificate.

7. Add the new OATS Certificate to the Address Book.

To Refresh the OATS Certificate Using Netscape Messenger



OATS Email Certificate Renewal Instructions

September 27, 2007 11

1. Click . The Security Info window appears.

2. Click the People link. All certificates that are loaded on your computer
appear.

3. Select the OATS Certificate.

4. Click or press the Delete key on your keyboard. A confirmation
message appears.

5. Click Yes to delete the OATS Certificate.

6. Request a new OATS Certificate.

7. Trust the new OATS Certificate.

8. Add the new OATS Certificate to the Address Book.

To Transmit a FORE Via Email

The first procedure applies only to Outlook Express 5.0 (which accompanies
Internet Explorer 4.0, version 4.72), while the second procedure applies only to
Netscape Messenger 4.72. The steps involved in transmitting a FORE via email
may vary for other mail clients and versions. Refer to “Managing the OATS
Certificate” in this chapter, for assistance in transmitting a FORE file via email.
For assistance in using versions other than those mentioned above, call FINRA
Business and Technology Support Services at 1-800-321-6273.

To Transmit a FORE File Via Email Using Outlook Express



OATS Email Certificate Renewal Instructions

September 27, 2007 12

1. Build a FORE file (refer to the OATS Reporting Technical Specifications for
layout and format).

2. Click . The New Message dialog box appears.

3. In the To box, type testoatsfiles@finra.org to access the test environment or
oatsfiles@finra.org to access the production environment. The Subject box
may be left blank (OATS ignores subject text).

4. Click . The Attachment dialog box appears.

5. Select your FORE file from the appropriate folder, and then click Attach.

6. On the toolbar, click to encrypt the message and to digitally sign the
message.

7. Click . OATS will reply with a status message called
NameofFOREFile Status Report within one hour. If you do not receive the
reply within one hour, perform the following checks:

a. Confirm that you typed the correct address and subject text in your email
message; if so, you may be experiencing a delay in receiving Internet
mail. Proceed to next step.

b. Check for FORE status on the OATS Web Interface (for procedure, see
Error! Reference source not found.“Error! Reference source not
found.”).

c. If you still have not received a response from OATS, contact FINRA
Business and Technology Support Services.

To Transmit a FORE Via Email Using Netscape Messenger
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1. Build a FORE file (refer to the OATS Reporting Technical Specifications for
layout and format).

2. Click . The Composition dialog box appears.

3. Click to display the Address tab. In the To box, type the appropriate
email address for the test or production environment. The Subject box may
be left blank (OATS ignores subject text).

4. Click , and then from the pop-up menu, click File. The Enter file to
attach dialog box appears.

5. Select your FORE file from the appropriate folder, and then click Open.

6. Click to display the Message Sending Options tab.

7. Click the Encrypted checkbox. Optionally, click the Signed checkbox.

8. Click . OATS will reply with a FORE status message called
NameofFOREFile Status Report within one hour. If you do not receive the
reply within one hour, perform the following checks:

a. Confirm that you typed the correct address and subject text in your email
message; if so, you may be experiencing a delay in receiving Internet
mail. Proceed to next step.

b. Check for FORE status on the OATS Web Interface.

c. If you still have not received a response from OATS, contact FINRA
Business and Technology Support Services.

Notes:

 You must use a unique Firm FORE ID for each FORE submission within a
single OATS Reporting Day. Any FORE submitted within a day that has a
duplicate Firm FORE ID will be rejected as a duplicate file.

 To avoid overwriting the corresponding FORE status files, use a unique
external filename for each FORE submission within one calendar month.

 An OSO that transmits files for several other firms must submit a separate
FORE for each firm. Each file must have a Firm FORE ID that is unique
within the OATS Reporting Day.


